
Introduction
Thank you for choosing SCIEX to supply your system. We are pleased to bring you the SCIEX OS
2.1.6 Software, which supports the following systems:

• ZenoTOFTM 7600 System

• SCIEX X500R QTOF System

• SCIEX X500B QTOF Systems

• SCIEX Triple QuadTM 7500 LC-MS/MS System – QTRAP® Ready

• Echo® MS System, which includes a SCIEX Triple QuadTM 6500+ System and the Echo® MS
Module

SCIEX OS 2.1.6 also allows the user to process data acquired from triple quadrupole, QTRAP®,
and TripleTOF® Systems operating the Analyst® Software, version 1.6.2 or higher, or the Analyst®

TF Software, version 1.7.1 or higher.

This document describes features in the software. We recommend that users keep these release
notes for reference as they become familiar with the software.

New in Version 2.1.6
This section describes the enhancements and fixes in SCIEXOS 2.1.6. To view the enhancements
and fixes for a previous release of SCIEX OS, refer to the Release Notes that came with that
version of the software.

New Features and Enhancements in Version 2.1.6
• SCIEX OS 2.1.6 supports the Echo® MS System with the SCIEX Triple QuadTM 6500+ Mass

Spectrometer.

Note: If this version of SCIEX OS will be used with an Echo® MS System, then the firmware
for the Echo® MS System must be updated. Contact a SCIEX field service employee (FSE).
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• The Software Updates feature allows the user to find out if a newer version of the software is
available.

Note: If the Software Updates feature is unable to communicate with SCIEX, then contact
the local network administrator to make sure that port 443 is open and that Transport Layer
Security (TLS) 1.2 is installed on the computer.

• SCIEX OS can be installed on an English, French, German, or Spanish Windows operating
system. English Language Support is required, but Regional Settings can be set to English,
French, or German. (BLT-2325)

• The character limit has been increased to 250 characters for the Barcode field in the Batch
workspace. (BLT-2212)

• Results Tables exported from SCIEX OS using the Export and save results table command
with the Analyst option selected now have the same format as Results Tables exported from
the Analyst® Software. (BLT-2365)

• (ExionLCTM and Shimadzu LC systems) The Direct Control feature has been enhanced to allow
the user to control parameters for the LC modules. (ONYX-8128)

• (SCIEX 7500 systems) The user is prompted for confirmation when specifying a Curtain Gas
value less than the recommended value. (ONYX-10763)

• In calculated columns, IF conditions can now test confidence traffic lights for these columns
(MQ-8469):

• Mass Confidence
• Fragment Mass Confidence
• RT Confidence
• Isotope Confidence
• Library Confidence
• Formula Confidence
• Combined Rules

New Features for Echo® MS Systems

• The user can choose to use the sampling sequence specified in the submitted batch or the
optimized (row-serpentine) sequence. Previously, only the optimized sequence was used,
regardless of the setting in the batch. To enable this option, select Tools > Settings in the
Direct device control dialog, and then clear theOptimize ejection sequence of batch samples
check box. (OPP-211)

• The flow rate for the mobile phase pump is now a moving average value. (OPP-327)

• The shortest duration supported for direct infusion is now 5 seconds. (OPP-307)
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• Simulation mode has been improved. (OPP-224)

• The idle time for the Echo® MS System can now be configured by selecting Tools > Settings
in the Direct device control dialog. (OPP-330)

• A mobile phase prime function is now available from the Direct device control dialog. Use this
function to fill the transfer line with mobile phase. To access the function, select Tools >
Maintenance. (OPP-347)

• AE Method information is now included in the sample information in the wiff2 file. (OPP-353)

• A new Run Log Level option creates a detailed log file as part of a service package. To select
this option, select Tools > Maintenance and then select Diagnostics in the Run Log Level
field. (OPP-399)

• The run time for the acquisition method has been optimized. For an AE method configured with
an interval of 1 second per well, the run time is reduced by approximately 17 seconds. (OPP-349)

• Acquisition is stopped if an error in the survey data or the marker well would make the acquisition
results unviable. (OPP-298, OPP-366)

Fixed Issues in Version 2.1.6
Echo® MS System

• The Echo® MS Module went into Fault state in Simulation mode. (ONYX-6697)

• In the Event Log workspace, the page with Echo® MSModule events showed as LC rather than
AE. (ONYX-7075)

• When the pump was stopped, the coupling fluid pump showed the last pump speed instead of
indicating zero. (OPP-276)

• Some critical Fault and Warning errors were not retained after a reset. (OPP-269)

• The system was not reinitialized after the clearing of faults and errors, such as the following,
that were triggered during initialization of acquisition:

• If acquisition is stopped during movement of the OPI (OPP-279)

• If the queue is stopped. (OPP-280)

• If the emergency off switch is activated during movement of the OPI. (OPP-283)

• If a fluidics leak or TFA overflow occurs during plate loading. (OPP-284)

• If an OPI or mobile phase leak occurs during plate loading and classifying. (OPP-285)

• If the mass spectrometer was in the Idle state, then the Echo® MSModule could not be purged.
(OPP-290)
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• The Plate Layout in the Batch workspace was not updated to match the plate type in an imported
csv file. (OPP-295).

• NECO Diagnostics showed an error if the Integration Service for the Echo® MS System was
running. (OPP-296)

• Intermittently the mobile phase pump did not start. (OPP-378)

• Intermittently the current plate took more than one attempt to unload, or the Unload button was
not enabled. (OPP-379)

• If the supply of Gas 1 to the mass spectrometer was not at the correct pressure (90 psi), then
acquisition did not start. The system stayed in the Pre-Run state. (OPP-319)

• When the Echo® MS System was operated in simulation mode, it went to Fault state after
acquisition completed. (OPP-301)

Other Devices

• (Shimadzu LC) After processing several samples, the pressure graph showed the pressure
dropping to zero briefly, before returning to its original pressure. (ACQ-2043)

• (ExionLCTM Systems) The software was unable to inject in steps of 0.1 µL for injection volumes
between 0.1 µL and 10 µL. (BLT-2189)

• Multiple LC devices could not be configured concurrently. (BLT-2206)

• (Shimadzu LC) When the LC system was deactivated, the LC system shut down and turned
off the chiller in the autosampler and the plate changer. (BLT-2300)

• (SCIEX 7500 systems) Communication with the syringe pump was lost. (BLT-2563)

• When an Agilent DADwas connected to a Shimadzu LC stack, there was a delay of 0.2 minutes
in the start of data acquisition for the DAD trace. (ONYX-8120)

• If the device configuration included a detector configured to acquire data in channel mode, and
the acquired data contains duplicate wavelengths, then the wavelength data shown in the Data
Acquisition panel and the Explorer workspace was incorrect. (ONYX-8382)

• If the scheduled ionization feature was used with a device configured with contact closure, then
ionization might begin before the device controlled through contact closure began injecting
sample. (ONYX-8626)

Batch Workspace

• (SCIEX 7500 systems) A text file exported from the Watson LIMS could not be imported to the
Batch workspace. (BLT-2460)

• Automatic processing failed if the file path specified for the Results File in the batch is too long.
(ONYX-8356)
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Analytics Workspace

• Only two decimal places were available for defining the retention time window. (BLT-1579)

• Customers could not open the Analytics workspace because of a communication issue with
the LibraryViewTM Software database (BLT-2110)

• The Calibration Curve pane showed a red cross. (BLT-2175)

• There were delays in updates to the workspace. For example, the Calibration Curve pane was
slow to update when a different component was selected in the Results Table and the Results
Table was slow to update when theReportable check box was cleared or selected. (BLT-2336)

• Admin access was required to export a library. (BLT-2439)

• When the user attempted to add a spectrum to the library, if a large number of similarly named
compounds already existed in the library, the user was prompted to create a new compound.
However, the compound could not be created because a compound with the same name was
already present in the library. (BLT-2452)

• Calculated columns based on combined rules were not updated automatically when the input
columns are updated. (BLT-2533)

• When the Peak Review pane was undocked and active, then the F4 shortcut key did not add
or remove the peak integration. (BLT-2551)

• Delays occurred during processing of a Results Table that contained samples that were currently
being acquired. (BLT-2560)

• When a table display settings (cset) file was imported, the Component Name column was
moved to near the right side of the table. (BLT-2564)

• Results might be inconsistent when text (non-numeric) comparisons were performed in complex
IF statements. (MQ-8268)

• The software did not inspect for mis-spelling of column names or values in formulas. (MQ-8412)

• Sample types of Quality Control and Double Blank were not recognized in IF statements.
(MQ-8549)

• If a text string in a formula included a semi-colon (;), then the formula was not processed
correctly. (MQ-8670)

• Changes to a Results Table might not be applied if multiple Results Tables were open and
three or more changes were made to the Results Table. (MQ-8696)

SCIEX OS Patches

The software includes fixes that were included in these patches:
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• SCIEX OS 2.0 Patch for Agilent Acquisition Issue: Intermittently, acquisition with an Agilent
device configuration might fail with the error “Sample acquisition was stopped because of a
system error”. (BLT-2160)

• SCIEX OS 2.0.1 Patch for Agilent CustomWell Plates. The software did not support customized
well plates defined for supported Agilent multisamplers: G5668A and G7167(A,B). (BLT-3422)

• SCIEX OS 2.0.1 Patch for Shimadzu Plate Layout:

• The Reversed Deep Well 96 plate layout was not supported for the Shimadzu LC30-AC
autosampler. This layout is similar to 96 Deep Well Plate, but vial numbering starts at the
bottom left, with rows being numbered from left to right. (BLT-2446)

• The Plate Layout dialog was not available for the Shimadzu SIL-30ACMP autosampler.
(BLT-2496)

Notes on Use and Known Issues

Notes on Use
• When performingWindows Updates, users should only install required updates. Updates should

be scheduled when the system is not acquiring data. Users should not install optional updates,
because they might impact functionality in the software.

Note: SCIEX OS does not support Windows 10 HotFix 2. (BLT-2320)

• When a batch starts, SCIEX OS stops the installation of Windows Updates, Windows Defender
virus scans (Windows 10), and Symantec Endpoint virus scans (Windows 7). Schedule updates
and virus scans to occur at times when data acquisition is not occurring.

• To avoid performance issues or data corruption, the user should not perform any computer
maintenance procedures, such as defragmentation or disk cleanup, during sample acquisition.

• (Echo® MS Systems) When an MS method is created, the Spray Voltage defaults to 4500 V.

Note:We recommend that a value of 5000 V or less be used, to maximize the life span of the
open port interface (OPI) electrode assembly.

• (Echo® MS Systems) Because the peaks are narrow, we recommend that the number of
transitions be minimized. We recommend that four to six transitions be used.

• (Echo® MS Systems) The user must not use the same data or results file name in multiple
batches. Always use a new data and results file in each new batch.
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• (Echo® MS Systems) Values entered in the Injection Volume column in the Batch workspace
do not replace the ejection volume specified in the AE method.

• If the ClearCore2 service is interrupted during network acquisition, then the partial sample data
for the sample under acquisition at the time of the interruption will not be written to the data file.
If the service is interrupted during local acquisition, then the partial sample data will be written
to the data file but will be marked as corrupted. Any auto-triggered processing and decision
rule processing will also fail if the ClearCore2 services is interrupted.

• The following methods allow the user to view data in real time in the Explorer workspace while
acquiring to a network resource:

• Open the Data Acquisition panel at the bottom of the SCIEX OS window.

• In the Queue workspace, open the sample being acquired by double-clicking it.
(DS-1873)

Note: If the sample is left open in the Explorer workspace, a "File not found message" is
shown after the sample has been moved to the network resource.

• Data files created in the SCIEXOS 2.1.6 cannot be appended to data files acquired in SCIEXOS
version 1.3.1 or earlier. (DS-1931)

• When specifying a new Results file for a sample in the Batch workspace, the user must also
specify a processing method. If no processing method is specified, then the ProcessingMethod
column in the Queue workspace will contain *Embedded Method* and automatic processing
fails. (ONYX-4864)

• MultiQuantTM Software files (qmethod, qsession, and cset) cannot be opened or used in the
Analytics workspace of SCIEX OS. However, MultiQuantTM Software methods that have been
exported to a text file can be imported into the Analytics workspace.

• The software does not use the selected regression parameter (Area or Height) to calculate the
ion ratio for a component. The software uses the regression parameter defined for the first
component in the Results Table to calculate the ion ratio for all of the components in the Results
Table. (MQ-5546)

• For non-targeted workflows, Results Tables should be limited to 150,000 rows. SCIEX OS
performance degrades significantly when Results Tables exceed this size.

• If the AutoPeak integration algorithm is used, then the user must consider all calculated
parameters in the context of a component within the specific Results Table. The software creates
an AutoPeak model for each component and this model is used for all samples for the
component. The AutoPeak Asymmetry calculated parameter shows the ratio of the skew of the
particular to the skew of the AutoPeak model for the component. (BLT-2030)

• When transferring data to the Watson LIMS, the user must wait for the transfer to complete
successfully before clickingConfirm in SCIEX OS. It the user clicksConfirm before the transfer
is complete, then the transfer status is shown as Failed.
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• The Apply to Workstation button is active even though the current audit map template is
applied to the workstation. To determine which audit map template is currently applied to the
workstation, open the Audit Trail workspace. (ONYX-3400)

• When converting methods, make sure to use the version of the SCIEX OS to Analyst® Software
Method Converter that is included in the SCIEX OS installation package.

General Issues
NotesIssue

This issue occurs if the Microsoft XPS Viewer is not
installed on the computer. The viewer is included in
the SCIEX OS installation package. To install it follow
these steps:
1. Run a Command Prompt as administrator:

a. In the Type here to search field in the
Windows Taskbar, type cmd.

b. Right-click Command Prompt and click Run
as administrator.

2. In the Administrator: Command Prompt window,
type the following command, and then press
Enter:
dism /online /norestart /add-package
/packagepath:"C:\ProgramFiles\SCIEX\SCIEX
OS\Microsoft-Windows-Xps-Xps-Viewer-Opt-
Package~31bf3856ad364e35~amd64~~.cab"

Note: Type the whole command on a single line.

A progress bar is shown as the XPS Viewer is
installed.

3. When the installation is complete, close the
Command Prompt window.

The user cannot open report (xps) files
created during in theMS Tune workspace,
during tuning, or in the MS Method
workspace, with Guided MRM. Windows
reports that it cannot open files of this type.

To avoid this issue, use the Analytics workspace in
SCIEX OS to process the data.

(SCIEX 7500 Systems) Data with a long
file path cannot be processed using the
Analyst® 1.7.2 Software. In addition, the
file information for such a data file cannot
be fully displayed in the Analyst® 1.7.2
Software. (BLT-2246)
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NotesIssue

The Help file is blocked. To resolve the issue, follow
these steps:

1. Browse to the Help file, right-click it, and then click
Properties.

2. In the Properties dialog, select Unblock.
3. Click OK.

Note: If the Properties dialog does not contain this
check box, then the Help file is not blocked.

The content pane of the Help is blank.
(BLT-2497)

To avoid the issue, make sure to use a shorter file
path.

(SCIEX 7500 Systems) Data with a file
path longer than 128 characters cannot be
processed in the Analyst® Software. Some
sections in the file information for such
data files are also not displayed.
(ONYX-9408)

wiff data cannot be reprocessed.An error occurs during reprocessing of wiff
data in the Explorer workspace and in the
Peak Review pane of the Analytics
workspace. (ONYX-9450)
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Devices Issues
NotesIssue

If theWAIT TIME for the column oven is manually set
to 0, then make sure to equilibrate the system and
wait for 10 to 15 minutes after the column oven has
reached the set temperature before submitting any
samples. Alternatively, set theWAIT TIME to a value
equal to any integer from 1 to 10 and then selectWait
for temperature equilibration before run in the LC
method. If this option is selected, then, after the
column oven reaches the set temperature, the
software will wait the amount of time specified in the
WAIT TIME before the beginning injection.

(ExionLCTM Systems and Shimadzu LC)
Injection begins before the column reaches
the set temperature.

The high throughput settings are not currently
supported.

(Agilent LC) High throughput settings are
not supported in the autosampler.
(ACQ-529)

If a sub-device is turned off prior to sample
submission, then the LC system goes to Standby state
even though the status should be Fault. If the user
attempts to submit the batch to the queue again, then
the first sample is submitted but fails immediately
because the LC system goes to Fault state and the
sample becomes corrupted. If this issue occurs, then
restart the computer and open the software again.

(Shimadzu LC) Incorrect device status is
shown when the device is recovering.
(ACQ-1410)

If the user opens the Direct Control device and then
clicks Clear Error when the LC is in Fault state, then
the device recovers but the status in the software still
indicates a fault. To clear this error, click Standby in
the status panel.

(Shimadzu LC) The device traffic light
does not update from Fault state when an
error is recovered through Direct Control.
(ACQ-1420)

To make sure that the system works correctly, either
turn off the devices or turn on the devices to match
the activated devices list.

(Agilent LC) The LC method does not run
correctly if the devices that are turned on
and connected do not match the devices
in the activated device list. (ACQ-1716)

The expected duration of the batch might be longer
than anticipated. To avoid any issues, use a sampling
rate lower than 12.5 Hz.

(Shimadzu LC) A performance issue is
observed during running of a long batch
using the Shimadzu PDA at sampling rates
higher than 12.5 Hz. (ACQ-2037)
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NotesIssue

This occurs when polarity is set to negative in the LC
method UV detector section. To avoid any issues, use
the positive setting for the polarity field.

(Shimadzu LC) Inverted UV data is
acquired during acquisition with two UV
channels. (ACQ-2042)

If this issue occurs, then click Standby to return the
LC to Ready state.

(Agilent LC) Agilent LC shows a Fault state
even when the sub-devices have
recovered from a fault and are in Ready
state. (ACQ-2144)

To avoid this issue, make sure that the value in the
Stop Time field for the LC method duration is the
longest time that the LC method must run.

When the duration of a gradient table for
an LC pump or column oven temperature
table in an LC method is longer than the
duration of the MS method, then the LC
devices will stop running when the MS
method duration expires.
(ACQ-2167/2088)

To avoid any issues, make sure that the correct
parameters are used for the PDA device.

(ExionLCTM AC/ExionLCTM AD Systems
and Shimadzu LC) The PDA default
parameters are different depending on
how the LC method is accessed.
(ACQ-2176)

This is an issue with the Agilent LC. To avoid this
issue, manually type the flow rate, using a comma as
the decimal separator.

(Agilent LC) The comma is ignored as a
decimal separator when the flow rate in
the LC gradient grid is copied. (ACQ-2191)

To avoid this issue, clear the fault in the device, then
deactivate and reactivate the Agilent devices.

(Agilent LC) The Fault state is not reflected
correctly if the devices are in Fault state
during device activation. (ACQ-2195)

In some cases, when devices are added manually,
the Test device function fails. To avoid this issue,
use Autoconfig to add devices.

In some cases, devices cannot be added
manually. (ACQ-3014)

Add a fourth rinse solvent, and reduce the volume of
each rinse to reduce the rinsing time.

When one, two, or three rinse solvents are
selected, then rinsing does not occur.
(BLT-1212)

N/A(Shimadzu LC-40) After the system goes
to Standby state, or after it is deactivated,
the temperature reverts to the temperature
that was set in the last equilibration
procedure or LC method. (BLT-2300)
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NotesIssue

If this issue occurs, then click Start in Direct Control
to change the CDS state from Fault to Running to
clear the Fault state of the CDS.

The system does not activate the Standby
button on the right status panel when a
device, such as the CDS, goes to fault,
preventing the user from clearing the error.
(MSCS-1314)

Activate the device again when themass spectrometer
is in the Ready or Idle state.

The mass spectrometer mass mode is not
shown if the mass spectrometer fails to
activate, or if it activates while it is in Fault
state. (MSCS-2065)

After installing SCIEX OS 1.7, stop the ClearCore2
service and then install the C++ redistributables
(vc_redis*.exe) from the Install folder in the SCIEXOS
2.0 installation package.

The user is unable to configure an SCIEX
X500 QTOF System in the Devices
workspace after downgrading from
SCIEX OS 2.0 to SCIEX OS 1.7.
(MSCS-2286)

This issue occurs if the Windows region settings are
set to a format other than English (United States).
To avoid this error, configure Windows following the
instructions in the Software Installation Guide.

Information is missing on the Device
Details dialog for the LC system.
(ON-2069)

This issue occurs when a sample vial is missing if one
or both of the following options is selected:
• If a sample ismissing, then proceed to the next

sample on the Queue Settings page.
• Ignore missing vessel on the Direct Control

dialog.

If neither of these options is selected, then the system
goes to Fault state and the sample fails.

To avoid this error, clear both of these options, and
then make sure that all vials are present.

(Agilent LC) If a sample vial is missing,
then the system fails to acknowledge the
missing vial and injects air. (ONYX-4849)

Apex and All in Peak spectrum mode are not
supported. Use a different mode.

(Agilent LC) Real-time DAD data from the
Agilent G7121B 1260 Infinity II FLD
Spectra module is not recorded when
spectrum mode is set to Apex or All in
Peak. (ONYX-4998)
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NotesIssue

If Signal A Excitation is set to Zero Order, then set the
PMT Gain to 6 or less.

(Agilent LC) The system remains in
Loading or Equilibrating state when a
Agilent G7121B 1260 Infinity II FLD
Spectra module is being used if the Signal
A Excitation is set to Zero Order and the
photo-multiplier (PMT) Gain is set to
greater than 6. (ONYX-4999)

N/AWhen the user presses F1 in the LC
Method workspace, both the SCIEX OS
Help System and the Help for the LC
system open. (ONYX-7149)

This issue occurs when the user disconnects and
reconnects the Remote Desktop session without
logging off the acquisition computer. To avoid this
issue, use one of these methods:
• Log off of the acquisition computer and then log

on again.

• Use Full Screen mode in the Remote Desktop
application.

• Correct the resolution on the acquisition computer.

• View the detailed status on the acquisition
computer directly.

When the Remote Desktop application is
used to access the acquisition computer,
the following issues might occur:

• In the LC Method workspace, some
parameters are not visible.

• On the Detailed Status dialog for an LC
system, some LC parameters are not
visible.

(ONYX-7153/ONYX-8048/ONYX-8185)

N/A(Shimadzu LC) The Nexera Mikros LC
pump does not go into fault state when the
maximum pressure limit is reached.
(ONYX-7794)

Wait for the next sample to start running, and then
open the Detailed Status dialog again to view the
Time.

In the Detailed Status dialog for the
diverter valve, the Time value is incorrect
while the system is in the equilibration and
loading states. (ONYX-7831)

The LC system performance is not affected, but the
pump is incorrectly identified in data files, logs, and
audit trails.

(Shimadzu LC) The Nexera Mikros LC
pump is incorrectly identified as an
LC-20AB pump in the device configuration.
(ONYX-8030)

13 / 49June 2021RUO-IDV-03-1821-S

SCIEX OS 2.1.6 Release Notes



NotesIssue

Save the batch and open it again, to show the plate
names correctly in the Plate Layout dialog.

(Shimadzu LC-40) In the Plate Layout
dialog, if the user is configuring a rack type
with multiple plates, then when the user
finishes configuring a plate and selects the
next plate, the name of the configured
plate changes to <Unassigned>.
(ONYX-8441)

Start the syringe pumpmanually before beginning the
tuning procedure.

SCIEX OS does not automatically start
and stop an external syringe pump during
tuning. (ONYX-8459)

N/A(ZenoTOFTM 7600 Systems) The name of
the OptiFlow® Turbo V Ion Source is not
correct in the Detailed Status pane.
(ONYX-10450)

• Do not use decision rules when an Echo® MS
System is configured in SCIEX OS.

• Do not activate an LC system when an Echo® MS
System is active.

• Do not do tuning in the MS Tune workspace when
an Echo® MS System is active.

Tuning of the SCIEX 6500+ System is performed
using the IonDriveTM Turbo V Ion Source and the
associated probe.

(Echo® MS System) The following
limitations apply:
• Decision rules do not work properly with

an Echo® MS System.

• An LC system cannot be used in a
configuration with an Echo® MS
System.

• The MS Tune workspace cannot be
used if an Echo® MS System is
configured.

(ONYX-10636)

N/A(Waters LC) LC device properties and
method information are missing from the
Sample Information shown in the Explorer
workspace. (ONYX-11604)

Set Run Log Level to Normal when detailed run log
files are not required.

(Echo® MS System) Setting Run Log
Level to Diagnostic affects system
performance. (OPP-399)
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NotesIssue

This is a user interface issue only. System functionality
is not affected.

(Echo® MS System) Intermittently, after
the pump is stopped, the flow rate shown
for the mobile phase is not zero.
(OPP-412)

Ejection of samples in column-serpentine sequence
is not recommended if the Optimize ejection
sequence of batch samples is cleared.

(Echo® MS System) Issues can occur
when the column-serpentine sampling
sequence is used:

• The drop-out rate for droplet capture
might be higher, resulting in poorer
reproducibility.

• The additional load resulting from
prolonged back-and-forth movement
along the Y-axis might cause stress on
the motion mechanism over time.

(OPP-211)

Acquisition Issues
NotesIssue

To delete the rows, select them, and then right-click
and click Delete Rows.

(Echo® MS Systems) When entries are
deleted in the Plate Layout dialog, the rows
are not deleted from the Batch workspace,
and some fields remain.

Click the SCIEX OS icon on the Windows Taskbar
to restore the SCIEX OS window.

(Echo®MSSystems)When the user closes
the Plate Layout dialog, SCIEX OS is
minimized to the Windows Taskbar.
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NotesIssue

To avoid any issues, print using the XPS option
instead of the PDFactory option.

In the Batch and Queue workspaces,
printouts using the PDFactory option have
the following issues:
• Reports generated with PDFactory do

not include any numeric values, such
as method names, sample names,
sample IDs, barcodes, and so on, where
the names are numbers. (ONYX-2236)

• Printing reports using XPS and
PDFactory in landscapemode works as
expected, but when PDFactory is used
in portrait mode, the last two columns
on the first page are omitted, and the
time at which the batch is printed is
truncated. (ACQ-1275)

If this issue occurs, then restart the software.In the Batch workspace, the list of available
MS and LC methods is incomplete if the
methods are copied from a different project.
(ACQ-2127)

To avoid this issue, do not use the Tab key to move
between cells. Remove the entire contents of the cell
and then type the Data File again.

An error is shown and the batch cannot be
submitted if theData File is centered in the
cell and the user presses Shift + Tab to
move to the next cell. (ACQ-2135)

Duringmanual acquisition using a SWATH® andMRM
HR method, the ion source gas and temperature
parameters are available to be edited in the user
interface. However, changes made by the user are
not updated to the mass spectrometer nor are the
changes logged in the sample information for that
sample.

(SCIEX X500 QTOF Systems) Ion source
parameters are not updated to the mass
spectrometer. (ACQ-2177)

To avoid this issue and clear the error, use the Direct
Control feature to start the syringe.

The Harvard syringe pump goes to Fault
state when Standby is selected.
(ACQ-2193)

To avoid this issue, do not add injection events to the
autosampler Time program table.

When a Shimadzu LC is used, the system
is unable to perform an injection if there
are injection events in the autosampler
Time program table. (ACQ-2242)
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Not all of the columns shown in the UI are shown in
printouts of the method when the user does the
following:
1. Creates an MRM HR method.

2. Applies a scan schedule.

3. Selects to show the advanced parameters.

4. Saves and then prints the method.

To avoid this issue, change the paper size to a size
larger than Letter size.

(SCIEX X500QTOF and ZenoTOFTM 7600
Systems) ForScheduledMRMHRmethods,
the mass table columns do not print.
(ACQ-2611)

To avoid any issues users can do one of the following:
• If the user submits a batch without a calibration

sample after finishing manual acquisition in the
MS Method workspace, then inter-sample
calibration behaves as expected. The first sample
in the batch is used to generate the reference list
to calibrate subsequent samples.

• If the user submits a batch with a calibration
sample while manual acquisition is in progress,
then inter-sample calibration behaves as expected,
with no mass accuracy drift observed.

(SCIEX X500 QTOF Systems) In manual
tune, if the user submits a batch without a
calibration sample (that is, no CDS- or
LC-autocal), then the ions from the manual
MS method acquisition are used as the
inter-sample DBC reference list for the first
sample and all the subsequent samples in
the batch. If there are any mismatches in
the mass range, polarity, and so forth,
between the MS method used for manual
acquisition and the one submitted in the
batch, then inter-sample calibration will fail
due to mass accuracy drift for all the
samples in the batch. (ACQ-2834)

Close the method and then open it again.When the user opens an MS method, the
Print button is not available. (ACQ-3301)

Information imported from an acquisition method has
a mass accuracy to two decimal places. Formulas
used to calculate mass accuracy in a processing
method produce results to four decimal places.
Therefore, this might cause inconsistent results
between the two methods.

Inconsistent behaviour occurs during
imports from an acquisition method and
from a processing method, resulting in
unreliable qualification results. (BLT-284)

Save, close, and open the method again.(SCIEX X500 QTOF Systems) For MRM
HRmethods, retention time is not validated
when the Method duration is changed in
the MS Method workspace. (BLT-961)

For enhanced batch stability, use the DAD in Signal
mode.

Batches fail when acquiring data with a
DAD in Spectrum mode. (BLT-978)
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To avoid this issue, either reduce the frequency of
the DAD acquisition or inspect the data after the
acquisition has completed.

Real time updates for the DAD panel might
be slower than the response time chosen
in the method (DS-853)

To avoid any issues, examine data post-acquisition
using the Explorer workspace.

Peak labelling is inconsistent between
XWC and TWC graphs during real time UV
data acquisition. (DS-1262)

These fields have been redefined in this version of
the software. Populate them again.

(Agilent LC) When a batch created with
SCIEX OS 1.2 or earlier is opened, LC
information, such as Rack code, Rack
position, and Plate code, is missing.
(DS-2186)

If this issue occurs, then clear the Wash mode option
in the Direct Control dialog.

(SCIEX X500 QTOF Systems) The CDS
remains in Wash mode after the software
stops responding. (MSCS-666)

When the APCI probe is used, a user message is
shown stating that the Ion source gas 2 setting should
be a specific value. Ignore the Ion source gas 2
settings in the user message.

The Ion source gas 2 setting is included in
a user message. (MSCS-943)

The error does not affect acquisition. Users can
cancel the message and acquisition will continue.

(SCIEX X500QTOFSystems) An incorrect
message is shown when the probe is
changed. (MSCS-972)

Do not use an inclusion list with IDA survey scans
that use the ScheduledMRMTM Algorithm with sMRM
triggering.

(SCIEX 7500 Systems) In an IDA method
with a survey scan that uses the Scheduled
MRMTM Algorithm with sMRM triggering,
the Inclusion list is not used.
(MSCS-2270)

• Turn off sMRM triggering in the looped Scheduled
MRMTM Algorithm experiment. The IDA intensity
threshold will be applied to the candidate masses
in the MRM survey scan.

• Change the MRM survey scan to use the
ScheduledMRMTM Algorithm instead, and set the
retention time of the compounds of interest to 0.
The IDA intensity threshold will be applied to the
candidate masses in the survey scan.

(SCIEX 7500 Systems) When an IDA
experiment with an MRM survey scan is
looped with another experiment that uses
the Scheduled MRMTM Algorithm with
sMRM triggering applied, the trigger
threshold specified in the Intensity
threshold exceeds field in the IDA criteria
is not applied to the candidate masses in
the MRM survey scan. (MSCS-2283)
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If EAD fragmentation is used, then the accumulation
time must be at least three times the reaction time.
If it is not, then no data is acquired. To resolve the
issue, increase the accumulation time.

(ZenoTOFTM 7600 Systems) No data is
acquired in EAD fragmentation mode.
(MSCS-2527)

The algorithm selects the correct precursors, so the
acquired data is correct.

(SCIEX X500QTOF and ZenoTOFTM 7600
Systems) Negative mass defect values are
shown with the incorrect sign in the Mass
Defect IDA criteria. (MSCS-2537)

This issue might occur if the user changes from the
Turbo VTM Ion Source to the OptiFlow® Turbo V Ion
Source. Deactivate the devices and then activate
them again.

(ZenoTOFTM 7600 Systems) Auto
Calibration is not available if the OptiFlow®

Turbo V Ion Source, with a NANO probe,
is installed, and contact closure is enabled.
(MSCS-2543)

To avoid any issues, make sure that the Google
update services (gupdate and gupdatem), if present
on the system, as well as Windows backup, are
disabled before running IDA.

Potential extra time is added to random
cycles during IDA acquisition.
(ONYX-1764)

Although the user interface is not updated, the correct
parameters are used and reflected in the file
information.

(SCIEX X500 QTOF Systems) The MS
Method workspace does not update to
show the correct information when running
the calibrant. (ONYX-2127)

This issue occurs if a text editor is used to add a
column, delimited by a comma (,), to a row in the csv
file, and the comma and column text are not added
to the other rows.

1. Export the Mass Table to a csv file.

2. Open the exported file in Microsoft Excel.

3. Edit the Mass Table.

4. Save the updated csv file.

5. Import the file again.

When a csv file is imported in the Mass
Table of an MS method, no error message
is shown if the number of columns in the
import file is greater than the number of
columns in the Mass Table. (ONYX-5216)
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To delete content in the Mass Table, use one of the
following methods:
• Use the Backspace key to delete the text.
• Double-click the cell to enter Edit mode, and then

use the Delete key.
Then type new text, if necessary.

In the MS Method workspace, when the
user is editing the Mass Table for an MS
method, the Delete key does not work.
(ONYX-5467/ONYX-7384)

Add missing components to the batch manually.When a row is copied from a file, such as
an Excel spreadsheet, and then pasted in
the grid in the Batch workspace, some
components are not added to the grid.
(ONYX-6068)

To avoid this issue, instead of pasting over an existing
row, insert an empty row and paste the new content
in it. Then delete the existing row.

When the user pastes a row over an
existing row in the Batch workspace, the
content is not pasted correctly.
(ONYX-6083)

If the list of MS methods in empty, then find and
delete the corrupt method.

When the Acquisition Methods folder
contains a corrupt MSmethod, then no MS
methods are available for selection in the
MS Method column in the Batch
workspace. (ONYX-6795)

N/AWhen the user stops the queue with the
option Stop after the current tasks are
completed, acquisition completes, but
processing does not start. (ONYX-6802)

When the first sample is processed, the Results file
is created and the processing method specified in
the Processing Method column is embedded in the
new Results file. Therefore, the embedded method
specified for the reinjected sample is the same as the
processing method specified for the first sample.

In the Queue workspace, samples that are
re-injected as the result of decision rule
processing show *Embedded Method* in
the Processing Method column, instead
of the name of the processing method
associated with the original sample.
(ONYX-6896)

Peak splitting is performed after data is acquired. If
a subsequent batch is acquiring data to a file while
the system is splitting peaks written to that file during
the previous acquisition, then a resource conflict
occurs. To avoid this issue, write data from each
batch to a separate data file.

(Echo® MS Systems) When consecutive
batches save data to the same data file,
peak splitting is unsuccessful, and
automatic processing fails. (ONYX-6904)
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Do not use Remote Desktop to control the acquisition
computer while acquiring IDA data.

If the acquisition computer is being
controlled by Windows Remote Desktop
while acquiring IDA data, then acquisition
performance might be slow, resulting in
loss of data points. (ONYX-7491)

Close the PDF file before printing the method, or save
with a different file name.

An error occurs when the user attempts to
print a method to a PDF file that is currently
open. (ONYX-7813)

When the user sets a default value for AF2 for MS3

experiments in Negative polarity, the default value is
not saved.

To save a default value for AF2 in Negative polarity,
first configure Positive polarity with the AF2 value
required for Negative polarity. Then change to
negative Polarity and save the default values.

(QTRAP® Systems) A default value for AF2
cannot be set for MS3 experiments in
Negative polarity. (ONYX-8041)

If the user selects a Combined flagging rule that is
not applied in the processing method, then no
decision rule processing is performed in the queue.

In the Decision Rule Configuration dialog,
when a processing method is selected, the
list in the Flagging Rules field might
include Combined flagging rules that are
defined in the processing method, but not
applied. That is, theApply Rule check box
is not selected. (ONYX-8352)

The Duration for an MS method that uses the
Scheduled MRMTM Algorithm might become invalid
if the scan time is too large. If the user attempts to
save the method, an error message is shown, and
the Duration field contains an error icon. If the user
specifies a valid method duration, changes the
duration back to the incorrect method duration, and
then saves the method, the method is saved
successfully.

Make sure to determine the correct method duration
before saving the method.

An MS method that uses the Scheduled
MRMTM Algorithm can be saved with an
invalid method duration. (ONXY-8443)

Change the document orientation to landscape in the
Print dialog before printing.

(SCIEX X500 QTOF Systems) When a
Scheduled MRMHR method is printed, the
report does not contain all of the columns
in the Mass Table. (ONYX-8563)
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The correct value for CE is used for acquisition.(SCIEX 7500 Systems) The polarity of the
collision energy (CE) parameter is shown
incorrectly in Negative IDA experiments
polarity. (ONYX-8566)

Click OK.(SCIEX 7500 Systems) An error is shown
during step 5 (Optimize Collision Energies)
if the user does not complete all of the
preceding steps, in order. (ONYX-8568)

N/A(SCIEX 7500 Systems) If multiple
transitions have the same retention and
dwell time, then only the last one is shown
in the tooltip in the Dwell Time graph in the
(s)MRM Plots dialog. (ONYX-8621)

If data is acquired with one version of SCIEX OS,
and then data is appended to the data file with
another version of SCIEX OS, then the software
version recorded in the wiff data file, as shown in the
Sample Information in the Analyst® Software, is
incorrect. The earlier software version is shown in
the File Info section.

The software version information shown in
the Sample Information in a wiff data file is
incorrect if the data is acquired with
different versions of SCIEX OS.
(ONYX-9522)

N/A(ZenoTOFTM 7600 Systems) The number
of cycles and cycle time shown in the
Sample Information for a sample in the
PeakView® Software is incorrect for a wiff
file acquired with the Scheduled MRMHR

Algorithm. (ONYX-10623)

Close SCIEX OS and open it again. The selection
lists contain the processing methods and results files
in the current project.

If a batch created in SCIEX OS 1.6 or
earlier is opened in the Batch workspace,
then the selection lists for the Processing
Method and Results File columns are
empty. (ONYX-11275)

Calibration parameters are recorded differently by
the Analyst® TF Software and SCIEX OS. The wiff
file follows the Analyst® TF Software model.

(ZenoTOFTM 7600 Systems) TOF Mass
Calibration parameters shown for the
sample in the wiff file do not match the
parameters shown in the wiff2 file.
(ONYX-11356)
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1. Save and close the method.

2. Open the method.

3. Clear Experiment scheduling on the Advanced
tab.
The looped experiment shows as unscheduled.

(SCIEX X500QTOF and ZenoTOFTM 7600
Systems) When a looped experiment is
created with complex scans, IDA, SWATH,
MRMHR, the looped experiment is shown
as a scheduled experiment, even though
user did not specify experiment scheduling.
(ONYX-11359)

Non-integer values are replaced by "0" on saving and
reopening of the method, but the data is acquired
correctly, with the non-integer value taken into
account.

(SCIEX X500QTOF and ZenoTOFTM 7600
Systems) The user can enter non-integer
values in the For field for Exclude former
candidate ions. (ONYX-11383)

Appending of data to a wiff file on a network resource
fails under the following conditions:

• The wiff file contains Analyst software data.

• The wiff file contains corrupt data.

• The wiff file is Read only.

• The user does not have write access to the wiff
file.

• The wiff file exceeds 2 GB in size.

SCIEXOSmight be unable to append data
to a wiff file on a network resource.
(ONYX-11437)

The data, the graph for the TOF MS TIC, the graphs
for the individual TOF MSMS TICs, the TOF MS
spectra, and the individual TOF MSMS spectra are
all identical in the Explorer workspace and the
PeakView® Software.

The graph for an IDA summed TOFMSMS
TIC is different in the Explorer workspace
(wiff2) than in the PeakView® Software
(wiff1). (ONYX-11599)
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If the issue occurs, then do one of the following:
• Close the software and then open it again.

• Open a saved batch then use the Plate Layout
dialog to update the Well Positions in that batch.

(Echo® MS Systems) When the user uses
the Plate Layout dialog to populate Well
Positions in the Batch workspace,
sometimes the Well Positions are not
populated. This issue might occur under
these conditions:

• When the user opens the Batch
workspace for the first time after
opening SCIEX OS.

• When the user tries to populate Well
Positions in an empty batch.

(ONYX-12525)

For better performance, remove the wells in the Batch
workspace grid. Select the wells in the grid, and then
right-click and select Cut.

(Echo® MS Systems) When the user clicks
Remove All on the Plate Layout dialog,
the software responds very slowly.
(ONYX-12726)

Make sure that the batch includes a valid processing
method.

(Echo®MSSystems) If an acquisition batch
is submitted by the third-party control
software without a valid processing
method, then processing fails. (OPP-287)

Before starting acquisition, make sure that the mobile
phase bottle contains enough mobile phase to
complete the planned acquisitions.

(Echo®MSSystems)When amobile phase
low warning is triggered during acquisition,
the acquisition fails. (OPP-288)

Select a different column in the target row and try
again.

(Echo® MS Systems) When the user uses
the Plate Layout dialog to add sample wells
to the grid in the Batch workspace, the
selected wells cannot be added. (OPP-365)

This is a user interface issue only. System
functionality is not affected

(Echo® MS Systems) The Est. Start Time
in the Queue workspace is not updated for
AE samples. (OPP-421)
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This error occurs if the root directory for a project has
been used as a root directory for the Analyst®

Software. The Analyst® Software creates one or more
of the following files in the Default/Project Information
folder in the root directory:
• ProjectSettings.atd

• Default Audit Map.cam

• Project.atd

If these files exist in the Project Information folder,
then delete them.

None of the Results Tables in a project
root directory will open.

To avoid issues, use one of the supported templates.
Refer to Default Templates.

No reports can be created from the
Results Table after a custom template that
contains both picture elements and a
query is used to create a csv report.
(BLT-1507)

For non-targeted workflows, limit processing to 20
samples at a time.

SCIEX OS stops responding during
processing when a non-targeted workflow
is being used. (BLT-2069)

Open the data in Explore mode in the Analyst®

Software.
For Analyst® Software data, Q3 Resolution
is reported as Maximum for LIT scans.
(DS-2220)

Currently, only the global settings are available for
Library Search.

Compound-specific acceptance criteria
are not available. (LBV-136)

The csv report is only supported if the report does not
contain any graphics.

The csv report does not support graphics
or logos. (MQ-1361)

The regression settings fields are not independent of
the algorithm selected. If the user changes a
regression setting field in one algorithm, then the
corresponding field in the other algorithms is also
changed. To avoid any issues, when switching
between algorithms, users must update the regression
settings as required for the algorithm.

Changing the regression setting for one
algorithm in the Project default page
updates the regression setting for the
other algorithms. (MQ-1376)

To avoid this issue, assign names to libraries before
importing them.

An error occurs when a library without a
name is imported. (MQ-1379)
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The user can manually change the Expected RT for
each component in the group.

The expected retention time of an
individual component that is part of a
group (the Update Retention Time
feature is set to Group) can be changed,
resulting in inconsistent expected retention
times and retention time windows in the
group. (MQ-1511)

In addition to the Library Search and Formula Finder
scores, the software uses the mass error, isotope,
and retention time scores to calculate the combined
score. To avoid including these scores, set the
weighting of each to zero.

The combined score is non-zero when
both the Library and Search Formula
Finder scores are zero or not available.
(MQ-1545)

To avoid any issues, manually reprocess the results
based on the updated library database.

Saved Results Tables are not
automatically updated when a library is
added or removed from the database.
(MQ-1684)

If this issue occurs, confirm retention time, peak
quality, and integration to determine if the compound
is a true positive.

The library search reports a
higher-than-expected purity score from
low quality spectra. (MQ-1679)

Licences for the licensed packages created with
LibraryView Package Builder 1.0 should be manually
copied to C:\Program
Files\SCIEX\LibraryView\LibraryViewFramework\Server.

Licences for licensed packages created
with LibraryView Package Builder are
saved to C:\Program Files\AB
SCIEX\LibraryView\bin. (MQ-1847)

Creating the report can take some time. The
PDFactory progress window, which is always shown
in the background, shows that the PDF creation is in
progress. Users can minimize all of the windows,
including SCIEX OS, to view the PDFactory progress
window.

The software seems unresponsive when
PDFactory is used to create a protected
PDF report from a Results Table that
contains more than 2,500 rows using the
Positive Hit template. (MQ-1896)

To avoid issues, either manually select the IS Name
or paste the IS column separately.

The IS Name cannot be pasted in the
Components Table in the Method Editor.
(MQ-2193)

To avoid any issues, users must open methods
created in earlier versions of SCIEX OS and correct
any errors. If errors are not corrected, then processing
time might be impacted.

Users are able to process data and create
a Results Table using an invalid method.
(MQ-2431)
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Do not use the AutoPeak integration algorithm for
UV/DAD/ADC data that has poor peak shape.

When the AutoPeak integration algorithm
is used on UV, DAD, or ADC data, the
model can take a very long time to build
before processing. (MQ-4421)

Type the values in the table.An error occurs when the user attempts
to copy values in the Upper Limit column
of the Concentration Acceptance or Values
per component type tables in the Flagging
Rules. (MQ-5599)

To calculate S/N, open the average m/z spectrum in
the Explorer workspace, perform manual
reconstruction, and then calculate S/N on the target
peak.

Note: This workaround requires Biotool Kit License.

1. Select the Average spectrum in the Peak Review
pane.

2. Click Open data exploration ( ).

3. Click Bio Tool Kit > Reconstruct Protein, enter
a resolution value, specify the reconstruction
parameters, and then perform reconstruction.

4. Calculate S/Nmanually. Refer to "Show the Graph
Selection Information" in the Software User Guide.

In the Mass Reconstruction workflow,
signal-to-noise (S/N) values reported in
the Results Table are not calculated
correctly for reconstructed peaks.
(MQ-7073)

For nominal mass systems, such as the SCIEX 7500
System, XIC width (ppm) is not supported. Use XIC
width (Da).

An error is shown when the user
configures the table settings on the
Components page of the processing
method to show Mass (Da) and Width
(ppm). (MQ-7709)

Assign a name that does not match a function name.Names of calculated columns cannot be
the same as function names. (MQ-8087)
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The GETSTAT function uses the Actual
Concentration values to identify replicates, but the
Statistics pane uses theActual Concentration values
after the user-specified Number format is applied. If
the Number format is set to 0.00, for example, a
concentration of 5.001 will be treated as 5.00 in the
Statistics pane.

The Percent CV shown in the Statistics
pane is different than the percent CV
calculated with the GETSTAT function.
(MQ-8211)

Do not create flagging rules that use the Outlier
Reasons column.

The software does not support flagging
rules based on the Outlier Reasons
column or on calculated columns based
on the Outlier Reasons column.
(MQ-8295/MQ-8381)

To refresh the metric plot, select a different component
in the Results Table, and then select the original
component again.

When a metric plot is applied to a column
based on a custom formula, changes to
any input of the formula are not reflected
in the Metric Plot immediately. (MQ-8524)

Do not use the Acquisition Date & Time column in
formulas.

The Acquisition Date & Time column is
not processed properly in formulas.
(MQ-8662)

To represent the boolean AND, use "&&". To represent
the boolean OR, use "||".

The formula editor does not identify
incorrect use of the ampersand (&) and
bar (|) characters in formulas. (MQ-8837)

Make sure to review all statements that follow a
boolean operator.

The formula editor does not identify syntax
errors that follow a boolean operator.
(MQ-8839)

Include the well location in the sample name.Viewing samples by name and well
location is slow. (ONYX-7457)

N/AThe ChemSpider database cannot be
accessed with a proxy server. (PV-632)

RUO-IDV-03-1821-SJune 202128 / 49

SCIEX OS 2.1.6 Release Notes



Explorer Workspace Issues
NotesIssue

If this issue occurs, then wait for the software to finish
processing in the Explorer workspace or avoid
processing a large amount of data during data
acquisition.

When a user processes large amounts of
data or multiple data files in the Explorer
workspace, the user interface might stop
responding and there could be delay
before the sample queue moves to the
next sample. (BLT-719)

This error occurs if the structure for the selected ion,
as predicted by Formula Finder, is not included in the
list of positive ions on the Elemental Composition tab
of the Formula Finder Settings dialog. For example,
for the ion at m/z 1004, Formula Finder matches to
(M+NH4)+. If this ion is not included in the list of
positive ions to search for, then an error occurs when
no matches are found.

The error "The requested action could not
be completed. Make sure your data is
complete and all fields contain appropriate
values" is shown in the Formula Finder.
(BLT-1423)

To avoid this issue, do the following:

• Generate XICs for the required experiment by
clicking File > Show XIC

• Generate the XIC/BPC post-acquisition.

• Close the XIC pane and reopen it.

The following issues can occur when the
user explores data during acquisition:
• Real time data does not match the

post-acquisition data if the XICs and
BPCs for scheduled scans are
generated before the scheduled time.
(DS-903)

• If the user toggles between MS
experiments using Move to next or
Move to previous in the Explorer
workspace to show an extracted ion
chromatogram (XIC) or base peak
chromatogram (BPC) generated in real
time, then only one point is shown in
the XIC/BPC pane.
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If this issue starts to occur, then wait for the acquisition
to complete before exploring the data.

A mismatch in the real time graph in the
MS and DADData Acquisition panels and
in the Explorer workspace occurs when
the LC method duration is longer than the
MS method. In this scenario, both the MS
and DAD Data Acquisition panels stop
updating at the end of MS method
duration, even though the UV, DAD, or
ADC channel continues to update in real
time in the Explorer workspace until the
end of the LC method acquisition time.
(DS-852)

The Z-axis (Detector Voltage) is labeled incorrectly.
To avoid any issue, use the Detector Optimization
Report or the Data Acquisition panel to inspect the
data acquired during the detector optimization process.

Detector optimization data is not shown
correctly in the Explorer workspace.
(DS-1044)

The value shown is correct because it represents the
centroid value of the peak. Click Fill Peaks to open
a better view of the peak. The peak label is placed on
the highest point of the peak in question, regardless
of its position. Therefore, the label might seem to be
in the incorrect position, but the value is correct.

If this issue occurs, then wait for the acquisition to
complete before exploring the data.

The number label in an XIC trace is
misleading in the Explorer workspace.
(PV-1009)
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NotesIssue

An error message is shown when a user does the
following:
1. Open two files in separate panes in the Explorer

workspace and then generate an XIC graph for
each file.

2. Combine the XIC graphs in a single pane.

3. In the XIC pane, highlight a region and then
double-click to generate a spectrum.

4. In the Process All Overlays? dialog that opens,
click All Overlaid and then click OK.
The error message "Incorrect Argument - invalid
cycle range" is shown instead of the spectrum.

To avoid any issues, select a narrower region where
the graphs are overlapped.

The user is unable to generate a spectrum
from a highlighted region in the XIC.
(PV-1104)

This issue does not affect the workflow.Sample information for IDA experiments
is not shown when the user opens a
Scheduled MRMTM data file, selects and
loads a sample, and then clicks Show
Sample Information. (PV-1330)
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MS Tune Workspace Issues
NotesIssue

During manual tuning the optimized parameter value
is not saved. To avoid any issues, complete all of the
tuning steps when in manual tuning mode.

(SCIEX X500 QTOF Systems) During
manual tuning, the optimized parameter
value is not saved to instrument definition
file after the user clicks Save Settings.
(ACQ-2519)

To avoid this issue, set the start and stop masses to
cover the Q1 center mass range.

(SCIEXX500QTOF and ZenoTOFTM 7600
Systems) When the Q1 center mass is
selected, the mass range of the real-time
spectrum is not updated correctly.
(DS-915)

Perform the tuning procedure again.(ZenoTOFTM 7600 Systems) If the mass
spectrometer is turned off within about five
minutes after calibration is completed in
the MS Tune workspace, then the
calibration settings are lost and the
previously saved calibration settings are
restored. (MSCS-2627)
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Reporter Issues
NotesIssue

This error occurs because the
TemplateContentControlManager is not installed.
Follow these steps:
1. Navigate to C:/Program Files/AB

Sciex/ReporterOfficeAddins/
TemplateContentControlManager.

2. Double-click
TemplateContentControlManager.vsto.

3. If the TemplateContentControlManager is installed,
then clickClose. Otherwise, click Install and then
follow the onscreen instructions.

A Microsoft Office Document
Customization error occurs when the user
tries to edit a report template.

N/AWhen the user creates a report containing
a Results Table, the last digit of the values
in custom columns is always "0".
(MQ-1885)

Create the report again.If the For Each Sample tag is removed
from a report template, then it cannot be
added back. (RPT-21)

Software Installation and Activation Issues
NotesIssue

To verify that the correct version of the software has
been installed, open SCIEX OS and click
Configuration > About.

In the Setup Wizard and the Windows
Programs and Features control panel, the
software version number is incorrectly
shown as 1.6 instead of 1.6.10.

Contact sciex.com/request-support. Only
Administrators should install or remove the software.

SCIEX OS might fail to install if an
incorrect user account is used. (BLT-340)
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NotesIssue

If two instances of the SCIEX OS Installation Wizard
are opened, and the user attempts to proceed with
the installation from the second instance, regardless
of whether the first instance is closed, then the
installation fails. To avoid this issue, open only a single
instance of the Installation Wizard and then proceed
with the installation.

SCIEX OS fails to install if more than one
instance of the InstallationWizard is open.
(BLT-341)

The software cannot be installed or used if the FIPS
option is enabled. The option is available at Local
Computer Policy > Computer Configuration >
Windows Settings > Security Settings > Local
Policies > Security Options in the Windows Control
Panel. Disable System cryptography: Use FIPS
compliant algorithms for encryption, hashing, and
signing.

If the Federal Information Processing
Standards (FIPS) option is enabled in
Windows, then installation of SCIEX OS
fails. (BLT-2193)

If a backup of the SCIEX OS 1.3 installation is not
available, then:
1. Remove SCIEX OS 2.0.

2. Remove the LibraryViewTM Framework.

3. Rename the C:\Program Data\SCIEX\ folder.

4. Rename the C:\Program Files\SCIEX\ folder.

5. Rename the D:\SCIEX OS Data\ folder.

6. Install SCIEX OS 1.3.

SCIEX OS must be reconfigured and all methods,
settings, users, and so on must be recreated.

When the software is downgraded from
version 2.0 to version 1.3, the Batch,
Queue, and User workspaces aremissing.
(OFX-489)

If a user tries to remove SCIEX OS 1.3 or later using
Setup.exe, the entry from Windows Programs and
Features for SCIEX OS is removed. However, the
program remains and can still be opened. To remove
SCIEX OS, run Setup.exe from the SCIEX OS folder
and then follow the on-screen instructions to install
the software. This process will add the entry for
SCIEX OS back to the Windows Programs and
Features list. Use the Programs and Features list to
remove SCIEX OS 1.3 or later.

SCIEX OS 1.3 or later is not removed
when a user tries to remove it using
Setup.exe. (ONYX-2124)
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NotesIssue

If this issue occurs, then:
1. Remove LibraryViewTM Software, if installed.

2. Remove the LibraryViewTM Framework, if installed.

3. Remove all of the Microsoft SQL Server 2008
components.

4. Shut down and then start the computer again.

5. Install SCIEX OS.

If the installation issue persists, it might be necessary
to remove the LibraryView.mdf and the
LibraryView_log.mdf files from the C:\Program
Files\Microsoft SQL
Servier\MSSQL10_50.SQLEXPRESS \MSSQL\DATA
folder.

Note: Because the libraries are stored in the mdf
files, any existing libraries will be removed if these
files are deleted and will have to be installed again.

Occasionally, SCIEX OS might fail to
install because of an issue with SQL
server or because of an issue with the
LibraryViewTM Framework. (ONYX-2987)

If this issue occurs, then install it with
Install/NDP472-KB4054530-x86-x64-AllOS-ENU.exe,
located in the installation package.

An error is shown when SCIEX OS is
installed on a computer without .NET
Framework 4.x. (ONYX-8028)

MS FW Updater Issues
DescriptionIssue

To update the mass spectrometer firmware, copy the
FirmwareUpdater folder to the D:\ drive and then run
the utility from that location.

The MS FW Updater utility cannot be run
from the DVD. (BLT-597)

SCIEXOS to Analyst®SoftwareMethodConverter Issues
DescriptionIssue

This issue occurs if an earlier version of the Method
Converter is used. Make sure to use the version of
the Method Converter included in the installation
package for SCIEX OS 2.1.6 .

A method cannot be converted from
SCIEXOS if the method contains an EMS
scan. (ONYX-12112)
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Default Templates
Additional NotesTemplate Description (as shown in

the Create Report dialog)
Template

N/AA report showing, for each sample, a
section including the File Information,
Sample Information, Analyte Results
Table, and overlaid chromatograms of
all of the analytes and internal
standard. The Analyte Results Table
is printed as shown in the Results
Table. All the qualitative confidence
traffic lights are listed at the beginning
of the table.

All Peaks Qual

This is an example report template
that has a Query attached -
Analyte20percent.Query.

A report showing, for each analyte, a
section including File Information, and
an XIC table for each Blank, Standard,
QC, and 20% of all Unknowns.

Analyte 20
percent Report

N/ATable of results showing Sample
Name, Calculated Concentrations and
Outliers for all samples in the batch
for the specific analyte and the
associated Internal Standard.

Analyte Summary

• Standards for which the Reportable
check box is cleared will not be
reported in the data table. Statistics
will not be affected by the
Reportable status.

• The report will show the regression
equation and graph, as shown and
calculated in the Calibration Curve
pane in the Analytics workspace,
based on the status of the Used
column.

A report showing the File Information,
Statistics Table (standards), and
Calibration Curve for analytes, one
page per analyte.

Calibration Curve
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

This report is specific to the Mass
Reconstruction workflow.

A report showing the Results Table
entries for each sample. All columns
visible in the Results Table are shown
in the report. The report also includes
the XIC chromatograph, average
spectrum, and reconstruction
spectrum, for each sample and
analyte.

Intact Quant All
Peaks and
Graphs

This report is specific to the Mass
Reconstruction workflow.

A report showing the Results Table
entries, the calibration curve, and the
statistics data for each analyte. The
Results Table includes Sample Name,
Sample Type, Analyte name, Actual
Concentration, Area, Height, Expected
MW, MW, MW Delta, Calculated
Concentration, and Accuracy.

Intact Quant
Analyte Summary
and Calibration
Curve

This report is specific to the Mass
Reconstruction workflow.

A report showing Results Table entries
for all samples. The Results Table
includes Sample Name, Sample Type,
Analyte Name, Actual Concentration,
Area, Height, ExpectedMW,MW,MW
Delta, Calculated Concentration,
Accuracy and Accuracy acceptance.

Intact Quant
Sample Summary

The state of theReportable check box
does not affect the report content. All
data points are included even if the
check boxes are cleared.

A report showing, for each analyte, a
section including the File Information
and a metric plot of the analyte peak
area.

Metric Plot

N/AA report showing, for each analyte, a
section including File Information,
Sample Results Table, and XIC table
for each sample - WILL GENERALLY
PRINT 2 PAGESPERANALYTE FOR
< 8 SAMPLES

MQ Analyte
Report 1

Only unknowns are reported.A report showing, for each analyte, a
section including File Information and
XIC table for each unknown sample -
WILL GENERALLY PRINT 2 PAGES
PER ANALYTE FOR < 8 SAMPLES

MQ Analyte
Report 2

37 / 49June 2021RUO-IDV-03-1821-S

SCIEX OS 2.1.6 Release Notes



Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

Only unknowns are reported.A report showing, for each analyte, a
section including File Information, and
Unknown Samples Summary Table.

MQ Analyte
Report 3

Only unknowns are reported.A report showing, for each unknown
sample, a section including File
Information, Sample info, and Results
Summary Table. The table is shown
as 2 columns to fit more samples per
page.

MQ Analyte
Report condensed
table

Only unknowns are reported.A report showing, for each analyte, a
section including File Information,
Sample Results Table, and a small
chromatogram for each sample.

MQ Analyte
Report with
chromatograms

Only header information, the logo, and
page numbers are shown in the report.

N/AMQ Blank
Template

For use with the Peptide Quantitation
dataset. Refer to the the second
example, the absolute quantitation
example, in the User Guide for the
MultiQuantTM Software.

N/AMQ Pep Quant

Quality Controls that have the
Reportable check box cleared will not
be included in the report, nor will they
be used in the calculations.

A report showing File Information, QC
Summary Table per analyte (values
with a CV higher than 20% are
highlighted), and QCDetailed Results
Table (values with an accuracy outside
of 80-120% are highlighted).

MQ QC Summary
1 with flags

N/AA report showing, for each sample, a
section including File Information,
Sample info, IS info, Analyte Results
Table, XIC table including IS and each
analyte - WILL GENERALLY PRINT
2 PAGES PER SAMPLE FOR < 8
SAMPLES

MQ Sample
Report 1
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

Only unknowns are reported.A report showing, for each unknown
sample, a section including File
Information, TIC, Sample Details,
Analyte XIC, and results in table form
-WILLGENERALLYPRINT 2PAGES
PER SAMPLE FOR < 8 SAMPLES

MQ Sample
Report 2

Only unknowns are reported.A report showing, for each unknown
sample, a section including File
Information, Sample info, and Results
Summary Table.

MQ Sample
Report 3

Only unknowns are reported.A report showing, for each unknown
sample, a section including File
Information, Sample info, and Results
Summary Table. The table is shown
as 2 columns to fit more analytes per
page.

MQ Sample
Report condensed
table

Only unknowns are reported.A report showing, for each sample, a
section including File Information,
Sample info, Analyte Results Table,
and a small chromatogram for each
analyte.

MQ Sample
Report with
chromatograms
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

• The associated query file is Sample
Report with Concentration
Threshold.query.

• Components must be named
"Cmpd X #", where X is any
character from A to F, and # is any
numerical value.
Example: In the report, a
component named "Cmpd A 1" will
be shown under the heading
Compound Group A; a
component named "Cmpd B 1" will
be shown under Compound
Group B, and so on.

• If components are in the same
group, then only the first
component, alphabetically, in the
group will be included in the report.
Example 1: If "Cmpd B 25" and
"Cmpd C 1" both belong to the
group "Grp", then "Cmpd C 1" will
not be in the report.

Example 2: If "Cmpd A 1", "Cmpd
A 2", and Cmpd A 3" are not
assigned to groups, then "Cmpd A
2" and "Cmpd A 3" will not be in the
report.

Example 3: If "Cmpd A 1", "Cmpd
A 2", and Cmpd A 3" are assigned
to groups 1, 2, and 3, respectively,
then all 3 components will be in the
report under the heading
Compound Group A.

A report showing, for each unknown
sample, a section including File
Information, Sample info, and Results
Sum

MQ Sample
Report with
Concentration
Threshold
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

N/AA report showing, for each unknown
sample, a section including File
Information, Sample info, and Results
Summary Table, overlay of all XIC.
Expected Ion ratios are calculated
automatically using any available
standards. Ratio values are placed in
custom columns within the Results
Table. Any values outside 20% of
expected are flagged. Quantifier
analyte names must end in a blank
space followed by the number 1. Ratio
ion analyte namesmust end in a blank
space followed a number between 2
and 9.

MQ Sample
Report with MRM
ratios 2

The associated query file is MRM
ratios EU.query.

A report showing, for each unknown
sample, a section including File
Information, Sample info, and Results
Summary Table. Expected Ion ratios
are calculated automatically using any
available standards. Ratio values are
placed in custom columns within the
Results Table. Any values outside of
expected are flagged (using EU
guidelines for ratio tolerances).
Quantifier analyte names must end in
a blank space followed by the number
1. Ratio ion analyte names must end
in a blank space followed a number
between 2 and 9.

MQ Sample
Report with MRM
ratios EU
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

N/AA report showing, for each unknown
sample, a section including File
Information, Sample info, and Results
Summary Table. Expected Ion ratios
are calculated automatically using any
available standards. Ratio values are
placed in custom columns within the
Results Table. Any values outside
20% of expected are flagged.
Quantifier analyte names must end in
a blank space followed by the number
1. Ratio ion analyte names must end
in a blank space followed a number
between 2 and 9.

MQ Sample
Report with MRM
ratios MQ EFAB
03

The associated query file is MRM
ratios.query.

A report showing, for each unknown
sample, a section including File
Information, Sample info, and Results
Summary Table. Expected Ion ratios
are calculated automatically using any
available standards. Ratio values are
placed in custom columns within the
Results Table. Any values outside
20% of expected are flagged.
Quantifier analyte names must end in
a blank space followed by the number
1. Ratio ion analyte names must end
in a blank space followed a number
between 2 and 9.

MQ Sample
Report with MRM
ratios

Standards and Quality Controls that
have the Reportable check box
cleared will not be shown in their
respective summary tables in the
report, nor will they be used in the
statistical calculations.

A report showing, for each sample, a
section including File Information,
Standards Summary Table, QC
Summary Table, Blanks Results
Table; then for each unknown sample
a section including File Information,
Sample info, IS info, Analyte Results
Table, XIC table including IS and each
analyte - WILL GENERALLY PRINT
2 PAGES PER SAMPLE FOR < 8
ANALYTES.

MQ Sample
Report with
standards, QC,
and blanks
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

This report is intended for use with the
Tutorial Dataset Heavy Light dataset.
Refer to the second example, the
relative quantitation example, in the
User Guide for the MultiQuantTM

Software.

N/AMQ Tutorial
Dataset Heavy
Light

N/AA report showing, for each selected
sample, a section including the File
Information, Sample Information, and
Analyte Results Table for the selected
analytes. The Analyte Results Table
is printed as shown in the Results
Table. All the qualitative confidence
traffic lights are listed at the beginning
of the table.

Per Sample
Quant-Qual

The hidden state of a row takes
precedence over the state of the
Reportable check box. If the
Reportable check box is selected but
the row is hidden, then the row is not
reported.

A report showing, for each selected
sample, a section including the File
Information, Sample Information, and
Analyte Results Table for the selected
analytes. The Analyte Results Table
is printed as shown in the Results
Table. All the qualitative confidence
traffic lights are listed at the beginning
of the table.

Per Sample
Quant-Qual
Visible Rows
Using Visible
Analyte
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

• If the component table has UV
components, then the UV trace is
reported under XIC graph in the
report.

Note: If the name of the UV
component is in the format
[compound_nameuv] or [uv], then
no UV traces are reported,
because the uv suffix is
associated with the UV MS Qual
report.

• If a sample is labeled as a QC and
there are 2 or more samples, then
the mean, STDEV, and %CV will
be calculated and included in a QC
summary table at the end of the
report.

• If the Reportable check box is
cleared for a QC row, then that row
will not be used for any calculations
in the QC summary table.

A report showing components for each
sample with a WYSIWYG table. XIC,
MS, and MS/MS are shown. A
statistics summary table for area is
shown at the end of the report.

Per sample
Quant-Qual with
statistics

N/AA report showing, for each analyte, a
section including the File Information,
Results Table, Calibration Curves, and
chromatograms including the internal
standard and each analyte. This
template is suitable for a Results Table
with a group defined in it.

Per Analyte
Quant-Qual
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

N/AA report showing, for each selected
sample, a section including the File
Information; Sample Information;
Analyte Results Table for the selected
analytes; overlaid chromatograms of
all of the analytes, internal standard,
and the XIC; the Acquired/Theoretical
MS spectra; and the Acquired/Library
MS/MS spectra for each selected
analyte. The Analyte Results Table is
printed as shown in the Results Table.
All the qualitative confidence traffic
lights are listed at the beginning of the
table.

Positive Hits Qual

Recommended to use CSV option for
Report format.

A report in a csv format showing, for
each sample, a section including the
File Information, Sample Information,
and Analyte Results Table.

Qual CSV report
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Additional NotesTemplate Description (as shown in
the Create Report dialog)

Template

N/AA report showing, for each sample, a
section of Analytes Summary Table.
This report template is suitable for a
Results Table with groups.

Sample Summary

• UVMS data should be processed
with the naming convention
compound 1 (any string) for the
mass spectrometer (MS)
component and compound 1uv
(any string plus uv) for the
corresponding UV component.

• Only the Mass error, Fragment
Mass Error, RT confidence,
Istotope confidence and Library
confidence traffic lights are shown.

• A graph table is created to shown
the individual components of the
Results Table, including the XIC,
MS1 trace, MS/MS trace, and
header information from compound
1, and the UV trace from compound
1uv. Refer to Figure 1.

• Analyte graphs are only repeated
for the MS experiments, not for the
not the UV experiments.

• If a sample is labeled as a QC and
there are 2 or more samples, then
the mean, STDEV, and %CV are
calculated and included in a QC
summary table at the end of the
report. Refer to Figure 1.

• If the Reportable check box is
cleared for a QC row, then that row
in not used for any calculations in
the QC summary table.

A report showing, for each sample, the
components of that sample and their
corresponding UV component with a
WYSIWYG table. XIC, MS, and
MS/MS are shown along with UV data.
A statistics summary table for area is
shown at the end of the report.

UV MS Qual
report
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Figure 1 Graph Table

Figure 2 Statistics Table

Contact Us

Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX University™
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SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical issues
that might arise. For more information, visit the SCIEX website at sciex.com or contact us in one
of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To view this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.

To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the Customer Reference DVD that comes with
the system or component.

The latest versions of the documentation are available on the SCIEX website, at
sciex.com/customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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This document is provided to customers who have purchased SCIEX equipment to use in the operation of
such SCIEX equipment. This document is copyright protected and any reproduction of this document or any
part of this document is strictly prohibited, except as SCIEX may authorize in writing.

Software that may be described in this document is furnished under a license agreement. It is against the
law to copy, modify, or distribute the software on any medium, except as specifically allowed in the license
agreement. Furthermore, the license agreement may prohibit the software from being disassembled, reverse
engineered, or decompiled for any purpose. Warranties are as stated therein.

Portions of this document may make reference to other manufacturers and/or their products, which may
contain parts whose names are registered as trademarks and/or function as trademarks of their respective
owners. Any such use is intended only to designate those manufacturers' products as supplied by SCIEX
for incorporation into its equipment and does not imply any right and/or license to use or permit others to
use such manufacturers' and/or their product names as trademarks.

SCIEX warranties are limited to those express warranties provided at the time of sale or license of its products
and are the sole and exclusive representations, warranties, and obligations of SCIEX. SCIEX makes no
other warranty of any kind whatsoever, expressed or implied, including without limitation, warranties of
merchantability or fitness for a particular purpose, whether arising from a statute or otherwise in law or from
a course of dealing or usage of trade, all of which are expressly disclaimed, and assumes no responsibility
or contingent liability, including indirect or consequential damages, for any use by the purchaser or for any
adverse circumstances arising therefrom.
(GEN-IDV-09-10816-D)

For Research Use Only. Not for use in Diagnostic Procedures.
Trademarks and/or registered trademarks mentioned herein, including associated logos, are the property
of AB Sciex Pte. Ltd., or their respective owners, in the United States and/or certain other countries (see
sciex.com/trademarks).

AB SCIEX™ is being used under license.
© 2021 DH Tech. Dev. Pte. Ltd.

AB Sciex Pte. Ltd.
Blk33, #04-06 Marsiling Industrial Estate Road 3
Woodlands Central Industrial Estate, Singapore 739256
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